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Le Club Robotique de l’INSA Strasbourg présente : 

LA PROGRAMMATION 

DE L’ATXMEGA 128A1 
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Présentation : 

L’ATXMéga est microcontrôleur récent fabriqué par Atmel. Nous l’avons utilisé 

en 2011 pour l’asservissement du robot et la commande de la pince. 

En voici les caractéristiques principales : 

-128 ko de mémoire de programme et 8 ko de RAM 

-horloge de 32 MHz maximum 

-8 Timers 

-4 modules UART 

-Décodeur de quadrature intégré 

Cette dernière caractéristique le rend très intéressant dans toutes les 

applications utilisant un codeur pour asservir un moteur en vitesse ou en 

position. 

De plus, ce microcontrôleur est disponible pré soudé sur une plaquette 

intégrant régulation 3,3V (tension d’alimentation de la puce), ce qui permet de 

s’affranchir des problèmes liés au découplage. 

C’est pour cela que nous l’utilisons pour l’asservissement de notre robot. 

La plaquette  ainsi que la documentation associée est disponible en suivant ce 

lien : 
http://www.bravekit.com/development_boards/atmel_avr_boards/Xmega_ATXmega128A1_b

oard_JTAG_PDI 

Le but de ce document est de vous permettre de le mettre en œuvre. 

Dans un premier temps, je vous donnerai le mode d’emploi pour installer la 

suite logicielle nécessaire pour la programmation. 

Ensuite, je vous présenterai les différents périphériques ainsi que leur 

programmation. 

 

 



Club Robotique de l’INSA Strasbourg 
24, Boulevard de la Victoire – 67084 STRASBOURG Cedex 

    http://www.insa-strasbourg.fr/club-robotique/ – club-robotique@insa-strasbourg.fr - 06 80 52 20 77           

La suite logicielle : 

 

Nous utilisons l’IDE Eclipse associé à différents plug-in. 

 

1) Téléchargez Eclipse à l’adresse suivante :    

http://www.eclipse.org/downloads/ 

Vous devez prendre la version Eclipse IDE for C/C++ Developers  

Si vous n’avez pas Java installé sur votre ordinateur, il faudra le télécharger et 

l’installer pour pouvoir utiliser Eclipse. 

Voir  http://www.oracle.com/technetwork/java/javase/downloads/index.html 

Il vous faudra le JRE. 

Une fois téléchargé, installez-le en suivant les instructions. 

2) Décompressez le fichier compressé eclipse. 

 

 

3) Lancez Eclipse en double-cliquant sur « eclipse.exe ». 

http://www.eclipse.org/downloads/
http://www.eclipse.org/downloads/packages/eclipse-ide-cc-developers-includes-incubating-components/indigor
http://www.oracle.com/technetwork/java/javase/downloads/index.html
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4) Tous vos projets sont rassemblés dans un dossier appelé workspace. Eclipse 

vous le demandera à chaque démarrage. 

 

5) Vous arriverez ensuite sur la page d’accueil d’Eclipse.  
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Pour pouvoir programmer notre microcontrôleur, nous devons installer l’AVR 

Eclipse plug-in. 

Pour cela, cliquez sur Help->Install new Software et entrez l’adresse 

http://avr-eclipse.sourceforge.net/updatesite/  dans le champ « work with ». 

Cliquez ensuite sur « Add » entrez le nom « AVR Eclipse Plugin » dans le champ 

name puis cliquez sur OK. 

Attendez ensuite d’avoir ceci : 

 

Cochez la case, cliquez sur la petite flèche à côté puis sélectionnez « AVR 

Eclipse Plugin ». 

 

http://avr-eclipse.sourceforge.net/updatesite/
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Cliquez sur Next, suivez les étapes jusqu’à ce l’installation commence. 

 

6) Pour le programmateur, vous avez le choix. Nous utilisons l’AVR ISP mkII. 

Il est disponible par exemple à cette adresse : 

http://fr.farnell.com/atmel/atavrisp2/programmateur-avr-mcu-

isp/dp/1135517 

 

Pour l’utiliser, nous avons besoin de WinAVR, qui est disponible ici : 

http://sourceforge.net/projects/winavr/files/WinAVR/ 

Prenez la version la plus récente. Il s’agit du premier élément. Cliquez dessus et 

téléchargez WinAVR-20100110-install.exe . 

 Ne pas installer WinAVR dans un chemin comportant des paranthèses. WinAvr 

installé dans le dossier Program Files(x86)  ne fonctionnera pas! 

Une fois installé, redémarrez Eclipse. Vous devriez à présent voir cette icône 

 en haut à gauche de la fenêtre d’Eclipse. 

 

  

http://fr.farnell.com/atmel/atavrisp2/programmateur-avr-mcu-isp/dp/1135517
http://fr.farnell.com/atmel/atavrisp2/programmateur-avr-mcu-isp/dp/1135517
http://sourceforge.net/projects/winavr/files/WinAVR/
http://sourceforge.net/projects/winavr/files/WinAVR/20100110/WinAVR-20100110-install.exe/download
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Le premier programme 

Nous allons maintenant écrire un programme de test. Le but est de faire 

clignoter la LED sur la platine. 

Nous allons commencer par créer un projet : 

File -> New -> C Project 

Dans Project name, entrez le nom du projet, par exemple Test. 

Dans Project type, sélectionnez le dossier AVR Cross Target Application puis 

Empty Project. 
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A gauche, dans project explorer, vous devez avoir ceci : 

 

Le project explorer affiche tous les fichiers du projet.  

Cliquez avec le bouton droit dessus, new -> C source file. 

Entrez les informations suivantes, puis cliquez sur Finish. 

 

 

Votre écran doit ressembler à ceci (sans autant de projets à gauche !) : 
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C’est parti, on peut maintenant taper notre premier programme. 

Juste une petite chose : Je vous conseille de télécharger les notes d’application 

de Atmel. Elles expliquent comment utiliser les différents périphériques et 

fournit les drivers qui nous seront utiles. 

Sur cette page, 

http://www.atmel.com/dyn/products/documents.asp?category_id=163&famil

y_id=607&subfamily_id=1965 vous trouverez une liste de documents. Le petit 

CD signifie que des exemples de programmes et des drivers sont 

téléchargeables et associés au document. 

Commencez par télécharger celle-ci : Il s’agit du driver des entrées-sorties. 

 

Par la suite, quand vous utiliserez d’autres périphériques, télécharger ce qui lui 

correspond. 

http://www.atmel.com/dyn/products/documents.asp?category_id=163&family_id=607&subfamily_id=1965
http://www.atmel.com/dyn/products/documents.asp?category_id=163&family_id=607&subfamily_id=1965
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Une fois les différents fichiers extraits, nous allons rajouter les drivers au projet 

pour pouvoir les utilise. 

Pour cela : 

Clic droit sur Test puis cliquez sur Import. 

Cette fenêtre s’ouvre. 

 

 

 

Sélectionnez File System puis cliquez sur Next. 
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Cliquez sur Browse puis allez chercher le dossier contenant les fichiers 

téléchargés. 

Nous avons besoin de 3 fichiers :  

-port_driver.c et port_driver.h qui sont, comme le nom l’indique, les drivers 

pour utiliser les ports d’entrées-sorties de la puce. 

-avr_compiler.h contient des définitions liées au processeur et au compilateur. 

On en a besoin pour notre programme. 

Notez la présence de IO.pdf qui explique tout le fonctionnement des entrées-

sorties de notre processeur. 
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Cliquez sur Finish. Votre Project explorer doit ressembler à ceci : 

 

Nous allons maintenant écrire notre premier programme. Je ne le détaille pas 

ici. Il s’agit juste d’un test pour vérifier l’installation des différents logiciels et du 

matériel. 
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Copiez-collez ceci dans main.c : 

#include "avr_compiler.h" 

#include <avr/io.h> 

#include "port_driver.h" 

 

int main(void) 

{ 

 unsigned int i=0; //Variables ce comptage (de 0 à 65535) 

 

 //Configuration de la patte de la LED en sortie 

 PORT_SetPinAsOutput(&PORTQ, 0b00000100); //La LED est branchée sur la 

//patte 2 du PORTQ 

 

 //Boucle infinie 

 while(1) 

 { 

//On change l'état de la LED(allumé devient éteint et 

//inversement) 

  PORT_TogglePins(&PORTQ, 0b00000100); 

  for(i=0;i<10000;i++); 

 } 

} 

Nous allons maintenant dire au compilateur quel processeur nous utilisons. En 

effet, ces logiciels permettent de programmer des dizaines de processeurs 

Atmel. 

Pour cela, nous allons à nouveau ouvrir la fenêtre des propriétés du projet : 

Clic droit sur le nom du projet dans le project explorer->Proprieties 

Cliquez ensuite sur la petite flèche à côté de AVR : et enfin sur Target 

Hardware. Vous obtenez la fenêtre suivante : 
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MCU Type : Sélectionnez ATXmega128A1 dans le menu déroulant. 

MCU Clock Frequency : 8000000 

Pour terminer, cliquez sur OK. 

Maintenant arrive un grand moment : Nous allons compiler le programme, 

c'est-à-dire transformer les fichiers textes (.c et .h) en instructions exécutables 

par le microcontrôleur.  

Avant toute compilation, il faut impérativement sauvegarder tous les fichiers 

que vous avez modifiés si vous voulez que vos modifications soient prises en 

compte. 

Pour cela, deux icônes existent :  sauvegarde uniquement le fichier affiché, 

          sauvegarde tous les fichiers modifiés. 

Eclipse propose quand même de sauvegarder automatiquement avant la 

compilation en activant l’option concernée :  

Allez dans Window->Preferences->General puis cliquez sur l’onglet Workspace. 

Cocher la case « Save automatically before build » 
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Cliquez sur le marteau en haut de l’IDE( ). 

Du texte doit défiler en bas de l’écran. Il s’agit d’informations sur l’avancement 

de la compilation. 

Une fois terminée, la console doit ressembler à cela : 
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Le plus important est ceci : Signifie que la compilation est réussie. 

 

 

Si une erreur est détectée, sa description s’affichera dans la console et au 

moins une croix rouge apparait dans le project explorer : Voici un exemple en 

cas d’erreur : 
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Ici, il s’agit d’une erreur de syntaxe : j’ai juste supprimé le point-virgule après le 

for (i=0 ;i<1000 ;i++). 

 

Si la compilation ne se déclenche pas, vérifier les chemins d’accès vers les 

utilitaires WinAVR : Window->Preferences->AVR->Paths 
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Le programmateur 

Maintenant, le programme est prêt à être transféré dans le microcontrôleur. 

Cette opération est réalisée par un programmateur. Il relie le PC  à la puce.  

 

Nous utilisons au club l’AVR ISP2 en photo ci-dessus. 

Branchez le programmateur à l’ordinateur par USB. 

Le PC va chercher le pilote. Vous devez l’installer manuellement : Annulez la 

recherche de Windows update et sélectionnez le dossier où vous avez installé 

WinAVR au début. 
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Si Windows se plaint de la non-signature du pilote, installez le quand-même. Si 

après cela, le périphérique n’est pas reconnu, téléchargez le .zip sur la même 

page que ce document. Exécutez ensuite install_x86 ou install_x64 selon votre 

version de Windows. 

Ensuite nous allons régler Eclipse et AVRDude pour utiliser ce programmateur : 

Comme lors du choix du processeur, ouvrez les propriétés du projet. 

Allez en suite dans la rubrique AVR, cliquez sur la flèche et enfin sur AVRDude 

 

A côté du menu déroulant « Programmer configuration », cliquez sur new et 

entrez ces paramètres : 
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Ensuite validez en cliquant sur OK. 

Dans l’onglet Fuses Bytes, sélectionnez « do not set fuses bytes » 

 

Dans l’onglet lockbits, idem : 

 

Validez le tous en cliquant sur OK. 

A présent, il faut paramétrer le linker pour que le fichier généré lors de la 

compilation soit un .hex et non un .elf. 
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Pour cela, ouvrez les propriétées du projet -> C/C++ Build -> Settings. 

 

Cochez « Generate HEX file for Flash memory » comme sur l’image puis cliquez 

sur OK. 

Ensuite, recompilez le projet. Dans la console, le message « Finished building: 

Asserv.hex » doit apparaitre. 

 

 

Le Final 
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Moment crucial, nous allons maintenant programmer l e microcontrôleur 

(enfin) ! 

*) L’alimentation du module : Le programmateur n’alimente pas la carte. Elle a 

besoin d’une alimentation externe pour pouvoir fonctionner, qui se branche 

entre VIN et GND. Elle se fait par le circuit imprimé de l’application. 

 

 

 

 

*) Connexion du programmateur : 

 

 

VIN(+) 12V Max 

GND(-) 

Fil du programmateur 

Détrompeur vers le 

haut 
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Une fois tous les éléments connectés, cliquez là-dessus   et le 

programme est envoyé dans l’ATXMega. Dès que la programmation est 

terminée, le programme s’exécute immédiatement. C’est gagné ! 

 

En cas d’erreur, ne vous énervez pas tout de suite, dans un grand nombre de 

cas, il s’agit d’une simple faute.(Erreur lors du suivi des instructions, oubli d’un ; 

…) 

Vérifiez bien vos réglages : 

->En cas de problèmes de compilation, si vous avez une erreur du type « ; or} 

or…  expected before… » C’est que vous avez fait une erreur de syntaxe. Le 

compilateur ne reconnait pas ce que vous avez écris.  

-> « could not find definition of… » Signifie qu’un mot utilisé n’est pas reconnu 

par le compilateur : faute de frappe dans les instructions, variables non 

déclarées... 

 

 

Platine 

Connecteur du 

programmateur 
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-> Si jamais vous ne pouvez pas programmer, qu’une fenêtre de ce type 

apparaît lorsque vous tentez de programmer, vérifiez les réglages du 

programmateur.  

 

Si tout est bon mais que ça ne fonctionne pas, allez dans le gestionnaire des 

périphériques et vérifiez que le programmateur est identifié dans une catégorie 

« Win32 ». Mettez le pilote à jour ou carrément réinstallez le périphérique. 

N’oubliez pas : Vous devez sélectionner le pilote dans le dossier WINAvr ! 

 

 

 

 

 

 

 

 

 

 

 


